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This report contains the data received from the participants in this test.  Since these participants are located in many countries around the world, and it is 
their option how the samples are to be used (e.g., training exercise, known or blind proficiency testing, research and development of new techniques, etc.),
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as such.  The Summary Comments are included for the benefit of participants to assist with maintaining or enhancing the quality of their results.  These 
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sections, and will change with every report.  



Forensic Audio Analysis Test 24-5591

The Forensic Audio Analysis test consisted of an evidence audio file. Participants were asked to enhance the audio file 
to minimize distracting elements, and clarify the speech from the incident contained in the file.

SAMPLE PREPARATION
A predetermined, staged event involving a digital audio recording of a microcassette tape recording was executed.

The .wma file was zipped and uploaded to the CTS Portal for participants to download. A MD5 and SHA1 hash value 
was calculated and provided for the compressed file to allow participants to validate the successful download of the 
file.

VERIFICATION: Predistribution results were consistent with each other and the manufacturer's preparation information. 
The combination of internal test validation and the responses received from the predistribution laboratories confirmed 
the expected responses. The following list of tools were utilized in the validation of this test: QuickHash-GUI (version 
3.3.4), MediaInfo (version 24.04), iZotope RX 11 Advanced Audio Editor, and Audacity (version 3.5.1). CTS does not 
endorse any particular tools.

PLEASE NOTE: Questions marked with asterisks (**) did not show a clear consensus during preliminary review of the 
participants' responses. Further information and discussion will be available in the final summary report.

Manufacturer's Information

SCENARIO PROVIDED TO PARTICIPANTS

A microcassette recording was made of an attorney calling in to a disciplinary hearing. Later, the microcassette was 
digitized into a .wma file (“01 Track 1.wma”). The submitter of this recording stated that the original microcassette is 
no longer available, but they need the speech in the digitized copy clarified in order to have it accurately transcribed.
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Manufacturer's Information, continued

 Question  Manufacturer ' s Response  -  Examination Questions

 What is the SHA - 256  hash value of the  01  Track  1 . wma file ?1-1

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94

Manufacturer's Response:

 What is the format of the audio file ?1-2

Windows Media Audio / Windows Media / WMA

Manufacturer's Response:

 How many audio channels are contained in the audio file ?  Report a numeric value .1-3

2

Manufacturer's Response:

 What is the length in time of the audio file ?1-4

10 minutes 7 seconds / 10:07

Manufacturer's Response:

 What is the bit depth of the audio file ?1-5

16 bit

Manufacturer's Response:

 What is the sample rate of the audio file ?1-6

44.1 kHz / 44,100 Hz

Manufacturer's Response:

 What is the average value of the fundamental frequency of the dominant tonal noise present ?  Are harmonics 
 of this tone present ?

1-7**

Manufacturer's Response:

Fundamental frequency average value: 179.8 Hz / 180 Hz
Harmonics present? Yes

 Question  Manufacturer ' s Response  -  Enhanced Audio Examination

 Describe the workflow used to clarify the audio ,  including specific software and filters applied .2-1

This was a free form question on methods and tools used. No manufacturer's response is provided.

Manufacturer's Response:
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Summary Comments

This test was designed to allow participants to assess their proficiency in data verification, media characterization, data 

analysis, signal analysis and enhancement of an audio file using their own tools and methods. The participants were 

provided with an audio file and were asked to answer questions as well as make enhancements to the audio file. Refer 

to Manufacturer’s Information for preparation details.

A total of 31 participants returned results for this test.

A variety of software tools were used by participants during their examination. The most frequently reported tools 

included Adobe Audition and Izotope RX.  

All but two examination questions achieved consensus responses greater than 95%. Question 1-5 did achieve a 

consensus, where 77.4% of participants reported the Manufacturer’s response of 16 bits, and 16% reported 32 bits. 

Question 1-7 was a two-part question. For this report, since a consensus was achieved for one part of the question and 

not the other, Question 1-7 is being shown together and as two individual questions. Separated, the questions are 

identified as 1-8 and 1-9. For question 1-8, which asks for the average value of the fundamental frequency of the 

dominant tonal noise present in the audio file, only 67% of participants reported the Manufacturer's response of 179 or 

180Hz. For question 1-9, which asks whether harmonics are present in this tone, 96.8% of participants reported the 

Manufacturer's response that they were present.

In a separate section of this test, participants were asked to perform specific enhancement steps to the audio file and 

submit these enhanced audio files to CTS. An expert reviewed the audio files submitted by participants and provided the 

observational notes present in Table 3.
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Forensic Audio Examination Responses

TABLE 1
 Question 1- 1 :  Examination Questions

Question 1-1: What is the SHA-256 hash value of the 01 Track 1.wma file?

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94 Manufacturer ' s 
 Response:

ResponseWebCode

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f9438J7PA

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F9444DZM9

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F9444HGK8

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f9473WPM8

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f947VUMEZ

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94937E24

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F949KQ6Z3

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F949LH8KX

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f949LLM26

1.1 58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA0322F4B232F94AD27MZ

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94APE4R4

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94AZWRHV

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94BU6ZTY

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94CVDERT

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94FVJZUP

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94GFQLDW

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94GNZAQV

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94HU2LMR

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94HX2XJR

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94J3UD9Q

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94LAN7UQ

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94N79P6G

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94N7GLJM

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94PDQBXL

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94T94UVJ

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94UAUK9B

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94UP9QJB
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TABLE 1
 Question 1- 1 :  Examination Questions

ResponseWebCode

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94X4F2LE

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94YPVLHE

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94Z2HGN6

58a3049158d544b9d0d4661749b6a53db2e010b6d9c57fa2ba03220f4b232f94ZUY4TC

Question 1-1: What is the SHA-256 hash value of the 01 Track 1.wma file?

58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94 Consensus Result:
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TABLE 1
 Question 1- 2 :  Examination Questions

Question 1-2: What is the format of the audio file?

Windows Media Audio / Windows Media / WMA Manufacturer ' s 
 Response:

ResponseWebCode

Advanced Systems Format (ASF) file container, containing Windows Media Audio 9.2 constant bit rate 
audio data

38J7PA

Windows Media Audio or .WMA44DZM9

Windows Media (.wma)44HGK8

.WMA73WPM8

WMA (Windows Media)7VUMEZ

WMA937E24

WMA9KQ6Z3

wma Windows Media Audio9LH8KX

WMA V29LLM26

WMA – Windows Media AudioAD27MZ

Windows MediaAPE4R4

WMA (Windows Media Audio)AZWRHV

.wma (Windows Media Audio)BU6ZTY

windows Media AudioCVDERT

wmaFVJZUP

Windows Media Audio (wma)GFQLDW

WMAGNZAQV

wmaHU2LMR

windows media audio(WMA) Version 2HX2XJR

Window Media AudioJ3UD9Q

Windows Media Audio (.wma)LAN7UQ

WMAN79P6G

WMAN7GLJM

WMAudioV2PDQBXL

Windows Media AudioT94UVJ

Format of file is WMA version 2. File container is asf (advanced system format).UAUK9B

.wmaUP9QJB

.wmaX4F2LE
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TABLE 1
 Question 1- 2 :  Examination Questions

ResponseWebCode

WMA (Windows Media Audio)YPVLHE

WMA (Version 2)Z2HGN6

Windows Media Audio(wma)ZUY4TC

Question 1-2: What is the format of the audio file?

Windows Media Audio / Windows Media / WMA Consensus Result:
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TABLE 1
 Question 1- 3 :  Examination Questions

Question 1-3: How many audio channels are contained in the audio file? Report a numeric value.

2 Manufacturer ' s 
 Response:

ResponseWebCode

238J7PA

244DZM9

244HGK8

273WPM8

27VUMEZ

2937E24

29KQ6Z3

29LH8KX

29LLM26

2AD27MZ

2APE4R4

2AZWRHV

2BU6ZTY

2CVDERT

2FVJZUP

2GFQLDW

2GNZAQV

2HU2LMR

2HX2XJR

2J3UD9Q

2LAN7UQ

2N79P6G

2N7GLJM

2PDQBXL

2T94UVJ

02UAUK9B

2UP9QJB

2X4F2LE
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TABLE 1
 Question 1- 3 :  Examination Questions

ResponseWebCode

2YPVLHE

2Z2HGN6

2ZUY4TC

Question 1-3: How many audio channels are contained in the audio file? Report a numeric value.

2 Consensus Result:
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TABLE 1
 Question 1- 4 :  Examination Questions

Question 1-4: What is the length in time of the audio file?

10 minutes 7 seconds / 10:07 Manufacturer ' s 
 Response:

ResponseWebCode

10 minutes, 7.062 seconds38J7PA

00:10:07.0644DZM9

10:07 minutes (10 minutes + 7 seconds)44HGK8

00:10:0773WPM8

00:10:07.063 (h:m:s:.ms)7VUMEZ

10 min, 7 sec937E24

10 min 7 s9KQ6Z3

10:07.062 10 minutes, 7 seconds, 62 milliseconds.9LH8KX

10 min 7 s9LLM26

10 minutes 7 secondsAD27MZ

10:07.062APE4R4

10min 7s 62msAZWRHV

10 minutes 7 seconds (00:10:07.062)BU6ZTY

(00:10:07) ten minutes and seven seconds.CVDERT

10 minutes 7 secondsFVJZUP

00:10:07:062 (hh:mm:ss:ms)GFQLDW

10 min 7 sGNZAQV

10 min 7 secHU2LMR

10 min 07 secHX2XJR

10 minutes 7 secondsJ3UD9Q

10 min 7 secondsLAN7UQ

9793895N79P6G

10 min 7 secN7GLJM

10:07.062PDQBXL

around 10 min 7 sek.T94UVJ

10 minutes 7 seconds.UAUK9B

10 minutes 7 seconds 62 millisecondsUP9QJB

10:07:062X4F2LE
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TABLE 1
 Question 1- 4 :  Examination Questions

ResponseWebCode

10:07.062YPVLHE

10:07.062Z2HGN6

00:10:07.108( 10 minutes and 07.108 seconds)ZUY4TC

Question 1-4: What is the length in time of the audio file?

10 minutes 7 seconds / 10:07 Consensus Result:
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TABLE 1
 Question 1- 5 :  Examination Questions

Question 1-5: What is the bit depth of the audio file?

16 bit Manufacturer ' s 
 Response:

ResponseWebCode

32 bits, but this may be a player representation after conversion/extraction of the WMA-data; the WMA 
codec standard from Microsoft states an encoder bit depth of 16 bits

38J7PA

1644DZM9

16 Bits44HGK8

16 bits73WPM8

167VUMEZ

16 bits937E24

169KQ6Z3

32-bit9LH8KX

16 bits9LLM26

16 bitsAD27MZ

16 bitsAPE4R4

16 bitAZWRHV

16 bitBU6ZTY

32 bitsCVDERT

16 bitsFVJZUP

32 bits floatGFQLDW

16GNZAQV

16 bitHU2LMR

16 bitsHX2XJR

16 bitsJ3UD9Q

16LAN7UQ

129 kbpsN79P6G

32 bitN7GLJM

16-bitPDQBXL

16T94UVJ

16 bitsUAUK9B

16 BitUP9QJB

16 bitsX4F2LE
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TABLE 1
 Question 1- 5 :  Examination Questions

ResponseWebCode

16YPVLHE

128 kb/sZ2HGN6

32 bitsZUY4TC

Question 1-5: What is the bit depth of the audio file?

16 bit Consensus Result:
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TABLE 1
 Question 1- 6 :  Examination Questions

Question 1-6: What is the sample rate of the audio file?

44.1 kHz / 44,100 Hz Manufacturer ' s 
 Response:

ResponseWebCode

44100 Hz38J7PA

44.1 kHz44DZM9

44.1 KHz44HGK8

44.1 kHz73WPM8

44 100 Hz7VUMEZ

44.1 kHz937E24

44.1 kHz9KQ6Z3

44100 Hz9LH8KX

44.1 kHz9LLM26

44.1 kHzAD27MZ

44.1 kHzAPE4R4

44.1 kHzAZWRHV

44.1 kHzBU6ZTY

44100 HzCVDERT

44.1 kHzFVJZUP

44100 HzGFQLDW

44100 HzGNZAQV

44.1 kHzHU2LMR

44.1 kHzHX2XJR

44.1 kHzJ3UD9Q

44.1 kHzLAN7UQ

44100N79P6G

44.1 KhzN7GLJM

44,100 HzPDQBXL

44100T94UVJ

44.1 kHzUAUK9B

44.1 kHzUP9QJB

44.1 kHzX4F2LE
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TABLE 1
 Question 1- 6 :  Examination Questions

ResponseWebCode

44.1 kHzYPVLHE

44,1 kHzZ2HGN6

44100 HzZUY4TC

Question 1-6: What is the sample rate of the audio file?

44.1 kHz / 44,100 Hz Consensus Result:
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TABLE 1
 Question 1- 7 :  Examination Questions

Question 1-7: What is the average value of the fundamental frequency of the dominant tonal noise 
present? Are harmonics of this tone present?

Fundamental frequency average value: 179.8 Hz / 180 Hz
Harmonics present? Yes

 Manufacturer ' s 
 Response:

Response ** Inconsistencies not highlighted; No consensus achieved **WebCode

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

38J7PA

Fundamental frequency average value: Fundamental frequency average value: 60 Hz, 
Harmonics present?: Yes

44DZM9

Fundamental frequency average value: 
Harmonics present?: Yes

44HGK8

Fundamental frequency average value: Mean F0 = 170 Hz, 
Harmonics present?: Yes

73WPM8

Fundamental frequency average value: 179,215 Hz, 
Harmonics present?: Yes

7VUMEZ

Fundamental frequency average value: 179.8 Hz, 
Harmonics present?: Yes

937E24

Fundamental frequency average value: 180, 
Harmonics present?: Yes

9KQ6Z3

Fundamental frequency average value: 180Hz, 
Harmonics present?: Yes

9LH8KX

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

9LLM26

Fundamental frequency average value: 155 Hz, 
Harmonics present?: Yes

AD27MZ

Fundamental frequency average value: 155.87 Hz, 
Harmonics present?: Yes

APE4R4

Fundamental frequency average value: 180, 
Harmonics present?: Yes

AZWRHV

Fundamental frequency average value: 180, 
Harmonics present?: Yes

BU6ZTY

Fundamental frequency average value: 8.44 Hz, 
Harmonics present?: Yes

CVDERT

Fundamental frequency average value: 155.29, 
Harmonics present?: Yes

FVJZUP

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

GFQLDW

Fundamental frequency average value: 179.86 Hz, 
Harmonics present?: Yes

GNZAQV

Fundamental frequency average value: approx 179hz, 
Harmonics present?: Yes

HU2LMR

Fundamental frequency average value: 180Hz as measured, possibly derived from 60Hz mains 
interference. multiples of 60Hz not detected. Harmonics only noted at 180Hz intervals., 
Harmonics present?: Yes

HX2XJR

Fundamental frequency average value: approximately 180 Hz, 
Harmonics present?: Yes

J3UD9Q

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

LAN7UQ
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TABLE 1
 Question 1- 7 :  Examination Questions

Response ** Inconsistencies not highlighted; No consensus achieved **WebCode

Fundamental frequency average value: 561.55, 
Harmonics present?: Yes

N79P6G

Fundamental frequency average value: 264.26, 
Harmonics present?: No

N7GLJM

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

PDQBXL

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

T94UVJ

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

UAUK9B

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

UP9QJB

Fundamental frequency average value: 177 Hz, 
Harmonics present?: Yes

X4F2LE

Fundamental frequency average value: 180Hz, 
Harmonics present?: Yes

YPVLHE

Fundamental frequency average value: 180 Hz, 
Harmonics present?: Yes

Z2HGN6

Fundamental frequency average value: 8.44 Hz, 
Harmonics present?: Yes

ZUY4TC

Question 1-7: What is the average value of the fundamental frequency of the dominant tonal noise 
present? Are harmonics of this tone present?

A consensus was not achieved for this question. Consensus Result:
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TABLE 1
 Question 1- 8 :  Examination Questions

Question 1-8: Fundamental frequency average value:

179.8 Hz / 180 Hz Manufacturer ' s 
 Response:

Response ** Inconsistencies not highlighted; No consensus achieved **WebCode

180 Hz38J7PA

60 Hz44DZM9

44HGK8

Mean F0 = 170 Hz73WPM8

179,215 Hz7VUMEZ

179.8 Hz937E24

1809KQ6Z3

180Hz9LH8KX

180 Hz9LLM26

155 HzAD27MZ

155.87 HzAPE4R4

180AZWRHV

180BU6ZTY

8.44 HzCVDERT

155.29FVJZUP

180 HzGFQLDW

179.86 HzGNZAQV

approx 179hzHU2LMR

180Hz as measured, possibly derived from 60Hz mains interference. multiples of 60Hz not detected. 
Harmonics only noted at 180Hz intervals.

HX2XJR

approximately 180 HzJ3UD9Q

180 HzLAN7UQ

561.55N79P6G

264.26N7GLJM

180 HzPDQBXL

180 HzT94UVJ

180 HzUAUK9B

180 HzUP9QJB

177 HzX4F2LE
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TABLE 1
 Question 1- 8 :  Examination Questions

Response ** Inconsistencies not highlighted; No consensus achieved **WebCode

180HzYPVLHE

180 HzZ2HGN6

8.44 HzZUY4TC

Question 1-8: Fundamental frequency average value:

A consensus was not achieved for this question. Approximately 67% of responding participants 
reported the manufacturer's response.

 Consensus Result:
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TABLE 1
 Question 1- 9 :  Examination Questions

Question 1-9: Harmonics present?

Yes Manufacturer ' s 
 Response:

ResponseWebCode

Yes38J7PA

Yes44DZM9

Yes44HGK8

Yes73WPM8

Yes7VUMEZ

Yes937E24

Yes9KQ6Z3

Yes9LH8KX

Yes9LLM26

YesAD27MZ

YesAPE4R4

YesAZWRHV

YesBU6ZTY

YesCVDERT

YesFVJZUP

YesGFQLDW

YesGNZAQV

YesHU2LMR

YesHX2XJR

YesJ3UD9Q

YesLAN7UQ

YesN79P6G

NoN7GLJM

YesPDQBXL

YesT94UVJ

YesUAUK9B

YesUP9QJB

YesX4F2LE
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TABLE 1
 Question 1- 9 :  Examination Questions

ResponseWebCode

YesYPVLHE

YesZ2HGN6

YesZUY4TC

Question 1-9: Harmonics present?

Yes Consensus Result:
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Forensic Audio Enhancement Responses
TABLE 2

 Question 2- 1 : Enhanced Audio Examination 
Question 2-1: Describe the workflow used to clarify the audio, including specific software and filters 
applied.

This was a free form question on methods and tools used. No manufacturer's response is 
provided.

 Manufacturer ' s 
 Expected Response:

ResponseWebCode

The file 01 Track 1.wma was opened in Adobe Audition (build 24.6.0.69). All next steps were done in 
Audition. Conversion to the Audition internal working format (32-bit floating point PCM WAV) was 
automatically done during opening of the file. In addition to auditory analysis (listening on high quality 
loudspeakers and headphones), the Spectral Frequency Display (spectrogram analysis) and Frequency 
Analysis (spectrum analysis) tools were used during analysis and enhancement steps. First, the different 
audio channels were analyzed. The file 01 Track 1.wma has two audio channels (a stereo audio file, with 
a left and a right channel). The right channel does not contain any speech information, only low-level 
noise and audio artefacts. The left channel contains speech information and clearly audible noise. The 
audio file was split into two separate mono audio files, where the following enhancement steps were 
applied on the audio from the original left channel. A Parametric EQ with the following setting was 
applied to remove low and high frequency noise: High Pass 24 dB/Oct @ 140 Hz, Low Pass 36 dB/Oct 
@ 3500 Hz. A series of Notch Filters were used to suppress noise at specific frequencies. Clearly audible 
improvement was achieved with the following notch filter settings: 180 Hz -36 dB; 360 Hz -30 dB; 540 Hz 
-30 dB; 720 Hz -20 dB; 900 Hz -20 dB; 1080 Hz -20 dB. Additional audible improvement was achieved 
with the following notch filter settings: 139 Hz -20 dB; 168 Hz -20 dB; 191 Hz -20 dB; 221 Hz -20 dB; 
348 Hz -15 dB; 371 Hz -15 dB. Additional improvement (less audible, but visible in spectrum and 
spectrogram) was achieved with the following notch filter settings: 1260 Hz -15 dB; 1439 Hz -15 dB; 
1619 Hz -10 dB; 1796 Hz -10 dB; 2510 Hz -10 dB. Next, a Noise profile was created from a part of the 
audio file where no speech and only noise was audible: time interval for the noise profile: 4:11.255 till 
4:12.989. With the Noise Reduction tool the noise in the recording was suppressed with the following 
settings: Noise Reduction: 40%, Reduce by: 6 dB. To suppress the peak at 0:00.45, a small fade-in, 
ending at 0:00.54, was applied. The amplitude of the audio was normalized to -0.5 dBFS. The audio was 
saved as 32-bit PCM WAV file with name "01 Track 1_L_enhanced_copy.wav". The original sampling 
frequency (44100 Hz) was not changed during the enhancement process and saving of the file. The 
SHA-256 value of the file 01 Track 1_L_enhanced_copy.wav is: 
685aaff18dd1a9a2ee0291f41650938f65e56d25289427f9fcbeaf4021fa9e0c. All steps were 
documented. A second researcher listened to the original audio and the final enhanced audio and made 
some independent observations, which were discussed with the first researcher (four-eyes / four-ears 
principle).

38J7PA

Performed virus/malware scan. No threats found. Made working copy. All work performed on working 
copy. Unzipped file "24-5591%20Audio.zip" using 7zip. The .zip folder contained one (1) audio file 
named "01 Track 1.wma" with SHA256: 
58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94 
Performed aural review, critical listening, waveform and spectral analysis using iZotope RX11 Advanced. 
Right channel had no speech signal. Left channel suffered from severe hum and harmonics. Challenges 
affecting intelligibility lasted entire duration of recording. Opened file "01 Track 1.wma" in Adobe Audition 
24.6.0.69. Split channels to mono and processed left channel only. Applied the following global filters: 
-iZotope RX11 De-hum -Waves Clarity Vx Pro Mono -Parametric Equalizer. Settings saved to screenshots 
below and as separate .PNG file (Note: SGWDE Best Practices for Enhancement of Digital Audio v1.2, 
Section 4.3.1.1 says that screenshots may serve as documentation of settings): See attached 
Audition_Settings.png. Compared input to output for all filters. Normalized to -1.0 dBFS. Saved as the 
following monaural WAV PCM file at 16-bit, 44.1 kHz: 01 Track 1_Enhanced.wav SHA256: 
1B49F3422D0B6F5D24B6191754D875D23BF7282084B4C4F39B992688CFDBA525. 
Performed final review comparing result to unprocessed original.

44DZM9

( 23 )Printed:  21-January-2025 Copyright ©2025 CTS, Inc



Forensic Audio Analysis Test 24-5591

TABLE 2
 Question 2- 1 : Enhanced Audio Examination 

ResponseWebCode
1. Format converting from .wma to .wav using formatfactory. 2. Capture noise print and noise reduction 
filter using Audacity software. 3. Denoise filter using Adobe Audition software. 4. capture noise print and 
noise reduction filter using Adobe Audition software. 5. amplify using Adobe Audition software.

44HGK8

Audio Enhancement process: 1. Channel Separation: The right channel was removed, and the left channel 
was selected for enhancement as it contained clearer speech data. 2. Critical Listening: Conducted an 
auditory review of the audio to identify masking noise, clipping distortion, and volume inconsistencies. 3. 
Apply Filters: A. Broadband Noise Filter: Used to reduce masking noise, with a suppression depth of 40% 
and an adaptation time of 0.2 seconds. Whitening was enabled to retain natural tonal balance. B. Clip 
Restorer (applied twice): - First instance: Suppression depth set to 49%. - Second instance: Suppression 
depth set to 44%. - Corrected clipped sections to restore lost audio peaks. C. Amplifier: Adjusted the 
volume to ensure consistent loudness, set near 0 dB. 4. Output: - The enhanced audio was saved in 
uncompressed PCM Wave format. - The original sample rate and bit depth were maintained. - The output 
file was converted to Mono, preserving only the left channel containing speech. 5. Review and 
Documentation: - Conducted a final critical listening to confirm speech intelligibility. - Documented all 
steps, including filters and settings, for reproducibility and compliance with SWGDE Best Practices.

73WPM8

Software: iZotope RX 10 v10.2.0.1760 Tools: Spectral repair, Voice de-noise, Dialogue isloate7VUMEZ

The audio was processed using iZotope RX Advanced v9.4.0 and the following filters: Mixing to duplicate 
the left channel to both channels of the audio, Normalize, EQ to reduce the hum, De-click, Voice 
De-noise, and Leveler. The processed audio was exported to a mono file.

937E24

Software used: iZotope RX 10 Advanced Audio Editor v10.4.2.2124. Load file "01 Track 1.wma." There 
appears to be no intelligible audio data in the RIGHT channel. Highlight entirety of LEFT channel > Right 
click > Copy > File > New from Clipboard. Entire file time period: 00.00.00.000 – 00.10.07.062 / 0 – 
26771456. Continue clarification on single channel. EQ: HP Brickwall 150 Hz Freq. LP 48 dB/oct 5545 
Hz Freq. De-hum: Time Period to Learn. 00:05:11.000 – 00:05:12.765 / 13715100 – 13792935. Filter 
Parameters: Filter DC offset checked/Filter type: Static/Frequency: 180/Q: 1000/-60.0 dB/Harmonics: 
14/Link harmonics: all/Slope: 0.50. Spectral De-noise: Time Period to Learn. 00:05:11.000 – 
00:05:12.765 / 13715100 – 13792935. Filter Parameters: Threshold Noisy: -4.5/Threshold Tonal: 
-4.5/Reduction Noisy: 12.5/Reduction Tonal: 14.7/Quality: C/ Artifact control: 7.0/Smoothing: 
2.0/Reduction curve checked/Algorithm Behavior Smoothing: 7.0 Algorithm: Extreme/Noise Floor 
Synthesis: 0.0/ Noise Floor Masking: 10.0/ Noise Floor Enhancement: 5.0/ Noise Floor Whitening: 
10.0/Dynamics Knee: 1.5/Dynamics Release (ms): 80 De-wind: Reduction:4.0/Crossover frequency (Hz): 
1200/Fundamental recovery: 6.0/Artifact smoothing: 3.5 Spectral De-noise (Adaptive): Adaptive mode 
checked/Learn time (s): 4.0/Threshold Noisy: -3.3/Threshold Tonal: -3.3/Reduction Noisy: 
14.0/Reduction Tonal: 14.0/Quality: C/ Artifact control: 6.0/Smoothing: 0.0/Reduction curve checked 
(not active)/Algorithm Behavior Smoothing: 7.0 Algorithm: Extreme/Noise Floor Synthesis: 0.0/ Noise 
Floor Masking: 10.0/ Noise Floor Enhancement: 5.0/ Noise Floor Whitening: 10.0/Dynamics Knee: 
1.5/Dynamics Release (ms): 80 Spectral De-noise: Time Period to Learn. 00:05:10.749 – 
00:05:12.804/13704033 – 13794668. Filter Parameters: Threshold Noisy: -1.4/Threshold Tonal: 
-1.4/Reduction Noisy: 17.9/Reduction Tonal: 17.9/Quality: C/ Artifact control: 5.0/Smoothing: 
0.0/Reduction curve checked (active)/Algorithm Behavior Smoothing: 7.0 Algorithm: Extreme/Noise Floor 
Synthesis: 0.0/ Noise Floor Masking: 10.0/ Noise Floor Enhancement: 5.0/ Noise Floor Whitening: 
10.0/Dynamics Knee: 1.5/Dynamics Release (ms): 80 EQ: Band 1 Bell/425 Hz Freq/6.2 dB gain/0.5 Q. 
Leveler: Optimize for: Dialogue/Target level: -22.1/Responsiveness: 4.1/Preserve dynamics: 25. 
Normalize: Target peak level (dBFS): -1.00. File > Export. Wav/Bit depth: 16-bit/Dither: White noise 
(TPDF). For more information, please refer to the document "24-5591 Audio Clarification 
Documentation.pdf

9KQ6Z3

1. Converted the file to 44100 Hz 32-bit mono PCM .wav file. 2. Captured noise print and applied Noise 
reduction - Adobe Audition 2024 3. Normalized entire file to -0.1dB - Adobe Audition 2024 4. Applied 
Spectral De-noise to entire file - iZotope RX6 pluggin within Adobe Audition 2024 5. Applied a 'Hard 
Limiter' to -6dB - Adobe Audition 2024 6. Normalized entire file to -0.1dB - Adobe Audition 2024 I 
initially tried applying a notch filter, but the results were better with the options listed above.

9LH8KX
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Adobe Audition: Extract the left channel from the original file. Apply filter to limit the voice signal band 
(300-3500 Hz) Apply Noise Reduction using the section 3:28 to 3:29 of the original file as the noise 
profile. Izotope RX: DE-HUM module to filter the effects of electrical noise. RUSTLE filter to eliminate 
crackles. LEVELER utility to level out signal variations optimized for Dialogue NORMALIZE to adjust the 
final signal level.

9LLM26

Adobe Audition software used. Workflow - High Pass filter. Noise print captured from first few seconds 
then applied using noise reduction filter. Added some Gain. Extracted the left channel to a mono 
recording in WAV PCM format.

AD27MZ

Software: Adobe audition 12.1.3.10; VoiceAI Cleaner™Intelligent Audio Denoise Workstation 3.1.3 
Workflow: 1.Analyze the voice to be inspected, and upon observing the spectrum, it is found that the voice 
content is concentrated in the left channel, with noise distributed across all frequency ranges. 
Simultaneously, there are stable harmonics at lower frequencies and an uneven distribution of harmonics 
at higher frequencies. Considering these issues, first, separate the left channel, then use inverse filtering to 
remove the stable harmonics at lower frequencies, followed by spectral subtraction to suppress other 
harmonics and background noise, and finally, enhance the required human voice through far-field noise 
reduction features. 2.Extract the audio file as a mono file and save the left channel as a separate 
recording file named "01 Track 1_L.wav". 3.Apply inverse filtering to the audio, set the filter length to 80 
(range 1-100), and choose 10 iterations (range 1-50). 4.select the pure noise section from 04:45.245 to 
04:46:237 seconds and perform noise capture. 5.Then carry out noise reduction on the entire audio 
based on spectral subtraction. 6.After that, enhance the required human voice through far-field noise 
reduction features. 7.Save the file.

APE4R4
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1 x .zip file downloaded from CTS-portal: - 24-5591%20Audio.zip. Transferred from laptop to evidential 
PC via encrypted USB drive. SHA-1 hash taken of .zip file using 7-zip (v24.01). Hash matches hash 
provided by CTS-portal. Contents of .zip file extracted using 7-zip. 1 x .wma file contained inside: - 01 
Track 1.wma. Audio quality assessment made using VLC (v3.0.16). L channel = High level static 
hum/buzz throughout duration of recording. High level broadband static noise throughout duration of 
recording. Low level bandwidth-limited male voice audible throughout. Sounds like voice recording is 
possibly a telephone or analogue radio recording. Listenability very low due to annoyance caused by low 
SNR. Speech partially intelligible. R channel = any audio is inaudible. Converted .wma file to 44.1kHz 
16bit 2ch PCM .wav file using WinFF (FFMPEG 6.0 script) - extensive testing has validated this method of 
conversion within the lab. Our standard procedures require that we convert all audio to 24 bit however as 
this test has asked for the original bit depth to be maintained, I have converted this audio file to 16bit and 
subsequent processing will be completed at this bit depth. Audio quality and duration checks made. I 
believe the conversion has been satisfactory to go ahead with subsequent processing. Converted .wav 
opened in Cambridge Cedar (v14.0.2.490) and following processing applied: - Channel configuration: 
Discard right channel and use left channel to produce dual mono audio - DuBuzz: Reduce buzz/hum 
noise - DNS (Dialogue Noise Suppression): reduce background noise - NR5 (Trained to 9'30 - 9'40): 
reduce broadband noise - 2 x FNR: improve voice clarity - VoicEX: improve voice clarity - Adaptive Limiter: 
Boost level. Audio rendered through processing modules and processed .wav file exported out of Cedar as 
44.1kHz 16bit 2ch PCM .wav. Processed .wav opened in iZotope RX (v10.3.0) and following processing 
applied: - EQ: High pass filter and low pass filter to reduce unwanted frequency content (speech is 
bandwidth limited) - Right hand channel discarded to give mono audio file (as requested) - Normalise: 
ensure audio is peaking at a suitable level (-0.5dBFS). See uploaded pdf doc for Cedar and RX processing 
settings. Overall I believe the processing to have made a large improvement to listenability. This version 
would greatly aid someone attempting to put together a transcript. This has mainly come from the 
reduction of the hum/buzz. There are however areas where the speech remains unintelligible. This is due 
to the poor SNR in the original recording as is unfortunately past the capabilities of the processing tools 
available. A peer review was completed by another competent practitioner. She had no suggestions for 
improvement. After her review we discussed the compromise between greater processing which would 
improve listenability but potentially at the expense of some intelligibility. Tests found that pushing the 
processing further caused audible artefacts in the speech and whilst being easier to listen to (particularly 
for long periods of time) there might have been some words that were more difficult to interpret. Therefore, 
for the purpose of this proficiency test I decided to be conservative with the processing. If this were a real 
case I would likely have made contact with the submitting party and provided them with an additional 
alternate version that had heavier processing so that they could use both versions to produce a transcript. 
Processed file exported out of iZotope RX: - 01 Track 1_Processed.wav. Output file inspected with 
MediaInfo (v22.03) - Duration: 10min 7s 62ms - 44.1kHz 16bit 1ch PCM .wav. 7-zip used to take 
SHA-256 hash of processed .wav file: 
ed8c7ebc97377abf7fc6f27bd18b73e8a62cc4484631c359f46efd36cd453e44 
Processed .wav file and PDF containing processing settings copied to internet enabled laptop via 
encrypted USB drive for upload to CTS portal

AZWRHV
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1. Received Forensic Proficiency testing 'Test 24-5591: Forensic Audio Analysis' from Supervisor. 2. 
Photographed provided Storage Device (SanDisk Ultra USB 3.0 32GB, Model SDCZ48-032G, SN: 
BM23120023944). Photographs available for view in case data. 3. Copied files from Storage Device to 
Forensic Data Case folder using: USB Write Blocker WB122, Analysis computer (Win10 x64) and 
TeraCopy version 3.17. a. USB Write Blocker WB122 was verified for use prior to connecting the Storage 
Device via a test USB file creation. b. Data copied from storage device was md5 hash generated and 
verified via TeraCopy 3.17. 4. Created a working copy of the original copied data. a. All files used from 
this point originate from working copy. b. All files md5 hash verified by TeraCopy 3.17. 5. Analyse audio 
file '01 Track 1.wma' using ffmpeg. a. //ffprobe -i "01 Track 1.wma" 6. Analyse audio file using iZotope 
RX9. Audio of relevance contained on left channel only. Copied left channel to new iZotope session. 
Disregarded right channel. 7. Enhance audio file '01 Track 1_left.wav' using iZotope RX9. Refer iZotope 
report for all filters and settings applied. Summary of clarification process: a. Document File information 
and Waveform Statistics. b. Remove identified DC offset using iZotope De-Hum. c. Remove hum of 
fundamental frequency (180hz) and harmonics using iZotope De-Hum. d. Fixed discontinuous waveforms 
using iZotope De-click. e. Low and high frequency cut using iZotope EQ.

BU6ZTY

 Sound Cleaner II being used to clean an audio file using multiple filters. These include the Broadband 
Noise Filter to reduce background noise, Click Suppressor to eliminate sharp noises, Dynamic Range 
Control to balance volume, Equalizer to adjust frequencies, Tone Suppressor to reduce low-frequency 
hums, and Reverb Suppressor to minimize echoes.

CVDERT

1. Open Adobe Audition. 2. Drag and drop audio file into the Files panel. 3. Double-click the audio file 
to open it in the Waveform Editor. 4. Play the audio and locate a portion where only noise is present. 5. 
Highlight this section. 6. Go to Effects > Noise Reduction/Restoration > Capture Noise 7. Click OK. 8. 
Highlight the entire audio file. 9. Go to Effects > Noise Reduction/Restoration > Noise Reduction 
(Process). 10. In the Noise Reduction panel: a. Adjust this slider to determine how much noise is removed. 
b. Set how much noise reduction is applied in decibels. 11. Repeat the same process for other noise that 
contain in the audio file. 12. After specific noise are removed, then go to Effects > Amplitude and 
Compression > Amplify to boost the speech in audio file. 13. Do the Normalization Process to remove the 
loudest peak to a specific level (I set it to -10 dB). 14. Save / Export the clean audio into WAV format.

FVJZUP

Process in adobe audition: 1. The channels were separated and the right channel was removed, as it did 
not contain any voice data. 2. Intense click reduction using the DeClicker filter. 3. Normal clip reduction 
using the DeClipper filter. 4. Scientific filter for subsonic vibration elimination (reduction of frequencies 
from 0 to 100 Hz) and reduction of frequencies from 8000 Hz to 22050 Hz to eliminate artifacts and 
other noises. 5. DeHummer filter for 180 Hz frequency and 8 harmonics at -35dB. 6. Band-reject filter at 
frequencies 140 Hz (-20dB), 220 Hz (-20dB), 1620 Hz (-15dB), 1800 Hz (-15dB), 2160 Hz (-10dB), and 
2520 Hz (-10dB). 7. Noise reduction by 12% and 32dB, FFT size 2048. 8. Hiss reduction by 8dB, noise 
base 8dB, FFT size 2048. 9. Vocal amplifier filter. 10. Reverb cancellation at 40%. 11. Normalize to 
-1dB. The sample is saved in .wav format (PCM), in mono, with the original file's sampling rate and bit 
depth.

GFQLDW

We used the Cedar Cambridge Forensic System. The workflow is the following: CEDAR Cambridge report 
24 Oct 2024, 09:30:30 Reference : Process manager chain: I/O sample rate : 44100.00; I/O channels 
: 1 PROCESS MANAGER Process Chain : channels : 1 sample rate : 44100.00 Debuzz-3: Current 
Settings : on/off: on; frequency : 179.86 Hz; threshold : 0.00 dB; reduction : -50.00 dB; bandwidth : 
3000.00 Hz; detection channels : 1; tracking : on; harmonic mode : all. NR5: Current Settings : on/off: 
on; level : 0.00 dB; noise reduction; gain : -5.00 dB LS1: frequency : 100.00 Hz; gain : -50.00 dB; slope 
: 120.00 dB/octave. HS2: frequency : 4500.00 Hz; gain : -50.00 dB; slope : 120.00 dB/octave; noise 
free EQ; gain : 0.00 dB. LS1: frequency : 100.00 Hz; gain : -50.00 dB; slope : 120.00 dB/octave. HS2: 
frequency : 4500.00 Hz; gain : -50.00 dB; slope : 120.00 dB/octave. Trinity Enhance: Current Settings : 
on/off: on; motor : 0.00; noise : 11.17; background : 0.00; speech : 29.33. FNR: Current Settings : 
on/off: on; speed : 0.20 Hz; resolution : optimal; bias : 0.00 dB; attenuation : -4.00 dB; focus : 70.00. 
Dehiss-3: Current Settings : on/off: on; threshold : 80.00 dB; attenuation : -15.00 dB; brightness : 0.00. 
Adaptive Limiter 2: Current Settings : on/off: on; input gain : 6.00 dB; threshold : -1.00 dB; spectral : 
0.00; HF temporal : 0.00; LF temporal : 0.00; oversample : off. MD5 hash value 01 Track 
1_cleaned.wav: c4148f7b0ab5981e3918b6cf87a6be93

GNZAQV
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Downloaded ZIP file and confirmed SHA1 value matched expected above. File 01 Track 1.wma imported 
directly into iZotope RX 9. Appears to be 2ch file. However, no audio is present on Rch. File exported as 
16bit WAV and converted to dual mono file. Resultant file reloaded in iZotope for processing. Recording 
contains speech with persistent hum. Occasional distortion present. Voice is masked by hum and very 
difficult to hear. Initial EQ applied 200Hz-4kHz to remove low end rumble and high end hiss. Hum not 
affected. Various notch and buzz filters attempted. Appears fundamental frequency is approx 179Hz and 
may drift slightly. iZotope D-Hum tool applied in dynamic adaptive mode which appears to attack hum 
adequately. Result is easier to listen to with hum level decreased. Dialogue Isolate filter applied which 
appears to make voice slightly more intelligible. Voice becomes very difficult to hear from approx 9min 
onwards and is effectively masked. Overall, resultant file is subjectively easier to listen to and more 
intelligible. However, voice is still masked at time. Resultant file converted to MONO file (as per CTS 
instructions), uploaded to CTS portal and attached to exam record.

HU2LMR

Zip folder "24-5591%20Audio" transferred from specified location. Unzip and extract the "01 Track 
1.wma" file. Transfer the wma file to a workstation in the Audio laboratory. Open the file within Cedar 
Cambridge software, conduct aural examination, and apply filtering solution. Note that signal is only 
apparent in the left channel of the audio file. Mono processing applied. Filtering modules applied: Gain - 
to reduce level going into the processing chain. DeBuzz - to remove buzz apparent in the audio. Trinity 
Enhance - to reduce some of the broadband noise and increase speech level. EQ - to improve 
intelligibility of target speech. Compressor - to maintain a more consistent output level. Gain applied to 
output of compressor, to increase the overall output level. FNR - to further reduce broadband noise. 
Adaptive limiter applied to final output. Render and save resultant audio file: "01 Track 1_processed.wav"

HX2XJR

The audio was imported into Adobe Audition and reviewed. The audio was in stereo, but the right channel 
did not contain speech. Extracted to mono and used the left channel for processing. Filters (including 
iZotope plugins) were applied to reduce noise and improve the intelligibility of the speech. Filters included: 
Parametric Equalizer, iZotope RX 10 De-hum, iZotope RX 10 De-crackle, iZotope RX 10 Spectral 
De-noise, iZotope RX 10 Voice De-noise, and Hard Limiter. The end of the file (approximately 
00:08:49-00:10:07) had lower talker levels and higher noise than the rest of the file. Additional filters 
were applied to this portion, including: iZotope RX 10 Voice De-noise and Hard Limiter. The processed file 
was exported as a .wav file.

J3UD9Q

First, SHA256 was extracted from the audio. Then the audio was converted to mono WAVE file (i.e. the 
channel, which contains speech, was preserved) with FFmpeg. Then the converted audio was cleaned with 
iZotope RX 10 using following filters: Gain, Spectral repair, Spectral Denoise and Loudness Control. 
Finally, edited audio was saved as 16 bit 44.1 kHz WAVE file. New SHA256 was extracted from the edited 
audio.

LAN7UQ

I have used Sound Cleaner II software for enhancement and clarifying the given audio file. Firstly, i upload 
the original audio file in to the Sound Cleaner II software then go to edit tab the choose the Divide stereo 
to two mono option. This will result in display two channel for current audio file (Right and left channel). 
The left channel will contain the audio file and the right channel shows empty. After extraction the audio 
file to mono will be in one channel as its requested in the question above. For the reduce noise and 
enhancement I do the following. Firstly, choose the left channel and choose Broadband Noise filter from 
filters option in the FILTRATION SCHEME. Then turn ON the Suppression Depth and put it to Max (40 dB). 
Then I choose Reverb Suppressor from filters option in the FILTRATION SCHEME. Then turn ON the 
Suppression Depth and put it to Max (40 dB). Last I choose Amplifier from filters option in the FILTRATION 
SCHEME. Then turn ON the Suppression Depth and put it to Max (12 dB). Then save the changes to the 
audio file and save it as PCM Wave format.

N79P6G

Load provided file into Adobe Audition. Review media information. There were found to be two channels. 
As the second channel did not contain any audio, the file was converted to mono. Applied the following 
filters in the following order: "Dehummer" (60hz), "Notch Filter", "Speech volume leveler." The enhanced 
file was written out as (1) WAV PC (44.1 khz and 32 bit).

N7GLJM
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I used Adobe(R) Audition v25.0.0.47 software to convert the WMA file to mono and apply an Effects Rack 
with the following filters: 1) adaptive iZotope RX 4 Denoiser. 2) BandPass filter of 100 Hz to 3500 Hz. 3) 
Notch Filter of -20 dB for 180 Hz, 360 Hz, 540 Hz, 720 Hz, 900 Hz, & 1080 Hz. 4) 2nd application of 
above Notch Filter. 5) Hard Limiter, with boost of 15 dB & maximum amplitude of -3 dB. I then applied a 
manual iZotope RX 4 Denoiser filter, with the Learned interval of 5:10.882 to 5:12.000. After applying the 
above filters, I exported the audio as a mono, 44,100 Hz, 16-bit Wave PCM file.

PDQBXL

1. 24-5591 Audio.zip file's hash verification. 2. Assessment: two channels, only one with speech signal; 
distortions: a) stationary noise with fundamental frequency on 180 Hz with harmonics b) broadband noise 
3. Preprocessing: using ffmpeg (version N-117899-g3c3bf6c109-20241125) WMA was converted to 
PCM maintaining original sampling rate and bit depth, next channels were splited; for further processing 
only left channel was used to enhanced due to lack of speech in right channel. 4. Audio enhancement: 
Applied software: Adobe Audition CS6 v.5 (Noch filter, FFT filter); Izotope RX v.10, (Dialogue Isolate, 
Spectral De-noise, Normalize). 5. Hash SHA-256 of the file "01 Track 
1_mono_U2726A_T94UVJ_final_version.wav": 
2A3052834E45146A6B87773B7122E6CDC8C38371088A1A95F0F2ED4954874C76.

T94UVJ

Software Used: Audacity version 3.7.0. Tasks listed in Part 2 were performed and one enhanced audio file 
named "enhanced audio.wav" was exported and is being provided on the accompanying DVD. 2-1 
Workflow used to clarify the audio, including specific software and filters for the audio enhancement is as 
follows: • Audio was enhanced using Audacity version 3.7.0; • The file was imported in Audacity. All the 
audio was selected, and Notch filter was applied. Notch filter Parameters: Frequency (Hz) : 
180,359,540,719,899,1079,1259,1439 and 1618 Q : 40 • A section of recording containing just 
noise was selected and the noise profile was generated using Noise Reduction filter. After that all the 
audio was selected and Noise was reduced. Noise Reduction Parameters: Noise reduction (db): 15; 
Sensitivity: 6.0; Frequency smoothing (bands): 6. • Graphic EQ filter was applied. Graphic EQ 
Parameters: A boost of 6db was applied to these frequencies (315,400,500,630,800 and 1K) Hz

UAUK9B

The .wma file was processed in "iZotope RX 10 Advanced (64-bit) v10.3.0.1775", "Sound Cleaner II" and 
"VoiceClean Intelligent Audio Denoise Workstation". iZotope RX 10 Advanced: -opened the file, selected 
the left-channel and copied, then created mono file with 'New from Clipboard'. -'De-hum' module to 
reduce tonal noise. Adaptive mode (selected), Filter type (Dynamic), Sensitivity 3.0, Bands 20, Filter Q 
340. -'Dialogue Isolate' module to attenuate background noise. Dialogue gain 0 dB, Noise gain -12 dB, 
Sensitivity 8.0, Ambience preservation 50, Quality (Best). Sound Cleaner II: -'Equalizer' module to filter out 
unwanted high-frequency information. Spectrum (Accumulate), Sclae (Log), FFT (2048), Inverse Filter, 
Threshold 3000 Hz. VoiceClean Intelligent Audio Denoise Workstation: -'Broadband Denoising' module to 
reduce background noise. Suppresion Strength 18 dB. The rendered audio was exported from VoiceClean 
as a 16 bit, 44.1 kHz, mono channel PCM wav file.

UP9QJB

Using Adobe Audition v.24.6.0.69, I determined the tone to be harmonic. Below are the steps taken for 
enhancement: 1) Notch filter 177 Hz increments 2) De-click: highlight click, lower amplitude to -16.2 dB 
3) De-hum 177 Hz increments, 8 harmonics 4) De-noise 60% all frequencies 5) De-reverb 10% low 
frequencies 6) Amplify +10 dB 7) Normalize 0.3 dB Saved derivative as an uncompressed PCM Wave 
format, maintaining original file sample rate of 44.1 kHz and bit depth of 16 bits, and one channel mono, 
containing speech data.

X4F2LE

Using Adobe Audition 2024: Left channel was exported as a mono audio track for enhancement. 32-Bit 
was chosen because the 16-bit option was not available. Frequency make up of the voice lies primarily 
between 200Hz – 2000Hz. Using iZotope RX10 Advanced: The De-Hum filter was used starting at 180Hz 
and covering 13 harmonics to reduce the humming noise. Using the EQ filter, a high pass filter was 
placed at 200Hz, and a low pass filter was placed at 2117Hz. The Spectral De-Noise filter was used to 
reduced broadband noise in the recording. The EQ filter was used again to placed notches at 220Hz and 
660Hz starting at 8:28 in the recording to reduce the buzzing noise. Clip gain was increased by +5.5dB 
for the whole recording. Exported as a 16-bit, 44.1kHz uncompressed .WAV audio file.

YPVLHE
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TABLE 2
 Question 2- 1 : Enhanced Audio Examination 

ResponseWebCode
To reduce the fundamental frequency of the dominant tonal noise the Brush selection tool (v 6) in Izotope 
RX 9 (v 5) was used. This was done in ten steps starting with the lowest frequency, to then continuing trying 
to remove the following nine found harmonics. After this the EQ (v 7) was used to apply a low pass filter 
set to 4500 Hz. This was done since little to none of the speech frequency could be found above this 
value. Further on the Spectral De-noise (Adaptive mode) (v 8) was used to reduce additional masking 
frequencies of the dominant tonal noise. To enhance the clarity of the speech an additional EQ (v 7) was 
applied. This time a comb filter was used to increase the speech frequencies that could be found in 
between the dominating tonal noise and its harmonics. After this the audio file was opened in Wavelab 
Pro (v 2) processed with the Q8 (v 3). This to enhance the significant middle-frequency for speech and 
thereby increase the speech intelligibility furthermore. Finally, the L1 Limiter (v 4) was applied to even out 
the dynamic range of the overall audio and thereby one last time increase the audibility of speech. The 
resulting file, 01_Track 1_Enhanced.wav, was saved as a Wave(PCM), 16 bit, fs. 44,1 kHz, mono file.

Z2HGN6

The Reference Noise (RN) Canceller removed interference from external signals, while an Equalizer 
adjusted specific frequency bands for better tonal balance. A Broadband Noise Filter eliminated consistent 
background noise across all frequencies, and Dynamic Range Control ensured consistent volume by 
managing peaks and amplifying quieter sections. The Reverb Suppressor minimized echo and 
reverberation, and finally, an Amplifier boosted the overall audio signal, resulting in a cleaner, more 
refined output.

ZUY4TC

Question 2-1: Describe the workflow used to clarify the audio, including specific software and filters 
applied.

This was a free form question on methods and tools used. No consensus response is provided. Consensus Result:
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Forensic Audio Enhancement Observations
TABLE 3

Part 2: Enhanced Audio Instructions - Use any methods or software tools deemed necessary to process the file, 
remove noise, or otherwise improve the intelligibility of the clip. The derivative file should achieve the following goals: 
Decrease the dynamic range of the multiple speakers, Increase the intelligibility of the words spoken, Decrease the 
level of noise and other unwanted sounds and Be free of clipping and other excessive artifacts or distractions from 
over processing.
A. Address / repair / reduce the impact of the four digital clicks / impulses in the first 20 seconds of the audio file, 
and any other clipping or distortions.
B. Using EQ or some other frequency specific tool, reduce or remove the beeps that repeat every 10 seconds. Be 
careful not to overprocess or affect more of the frequency spectrum than necessary.
C. Improve the signal to noise ratio by increasing the difference in level between the speaking and background 
sounds.
D. Reduce the difference in level between the loud and quiet parts of the speech. (Each speaker should be heard at a 
comparable level to each other if possible.)
E. Normalize or manually adjust the overall level of the clip to achieve a peak level value of -1dBFS.
F. Save your derivative file with the following parameters: a) Format: .wav/PCM, b) 24 bit, 48,000 Hz sample rate.

WebCode Observational Notes

38J7PA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float.

44DZM9 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

44HGK8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file 
as 2-channel audio with the essentially blank Right Channel included.

73WPM8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float.

7VUMEZ Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). File was saved as 2-channel 
audio with the essentially blank Right Channel included. While noise was significantly reduced, the 
speech sounds more "muffled" due to over-processing, with filtering artifacts being prominent.

937E24 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

9KQ6Z3 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

9LH8KX Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float.

9LLM26 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

AD27MZ Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following note(s). While overall noise was reduced, 
gain was increased too much resulting in clipping artifacts.

APE4R4 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float.
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TABLE 3
Forensic Audio Enhancement Observations

WebCode Observational Notes

AZWRHV Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

BU6ZTY Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

CVDERT Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). While the participant saved the 
file with a ".wav" extension, it is a MPEG-4/AAC LC format file instead of the PCM Wave that was 
requested.

FVJZUP Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). File was saved as 2-channel 
audio with the essentially blank Right Channel included. While overall noise was reduced, gain was 
increased too much resulting in clipping artifacts.

GFQLDW Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float.

GNZAQV Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

HU2LMR Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

HX2XJR Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

J3UD9Q Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

LAN7UQ Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

N79P6G Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float. While overall noise was reduced, gain was increased too much resulting in clipping 
artifacts.

N7GLJM Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float. The fundamental frequency of the tonal noise in this recording is approx. 180Hz. By using 
the default Base Filter Frequency setting of 60Hz in DeHummer (likely with 8 harmonics selected), 
noise bands were attenuated from 60Hz to 480Hz in 60Hz increments. This attacked the first two 
noise bands at 180Hz and 360Hz but left all the other 180Hz harmonics above 480Hz. Setting 
DeHummer to attack the fundamental frequency of 180Hz would have attenuated harmonics up to 
1440Hz. Additional noise reduction filters could be used to increase intelligibility. The Notch filter 
applied at approx. 5kHz had no effect on noise or intelligibility.

PDQBXL Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

T94UVJ Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following note(s). While noise was significantly 
reduced, the speech sounds more "muffled" due to over-processing, with filtering artifacts being 
prominent.

UAUK9B Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

( 32 )Printed:  21-January-2025 Copyright ©2025 CTS, Inc



Forensic Audio Analysis Test 24-5591

TABLE 3
Forensic Audio Enhancement Observations

WebCode Observational Notes

UP9QJB Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

X4F2LE Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

YPVLHE Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

Z2HGN6 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

ZUY4TC Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). The participant saved the file in 
PCM Wave format, maintaining the original 44.1kHz sample rate, but bit depth was increased to 
32-bit float.
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Additional Comments
TABLE 4

Additional CommentsWebCode

For question 1-7, the fundamental frequency had low amplitude and was difficult to measure. The 
harmonics were much stronger. However, based on even and odd-ordered harmonic multiples, the 
fundamental average is 60 Hz. The poor frequency response of the microcassette likely rolled off most of 
the lower frequency content.

44DZM9

I have also taken screenshots of all the filters used and the settings applied if required9LH8KX

I applied the repair assistant in Izotope and it also did a good job. Left a bit of noise behind but very 
useful.

AD27MZ

Hope the testing items can be released before July.APE4R4

Unable to check hash of uploaded file but would recommend hash is checked on download of 
processed .wav file. On delivery of processed file would advise receiving party attends the audio lab 
where they will be able to use a good quality pair of headphones in a quiet listening environment to 
listen to audio.

AZWRHV

Jacksum Name: 01 Track 1.wma Size: 9793895 bytes (9564 KiB) SHA256: 
58A3049158D544B9D0D4661749B6A53DB2E010B6D9C57FA2BA03220F4B232F94 FFMPEG v7.1 
FFPROBE Input #0, asf, from '.\01 Track 1.wma': Metadata: title : Track 1 album : Unknown album 
(8/22/2016 10:51:04 AM) WM/Track : 0 track : 1 WMFSDKVersion : 12.0.22621.3527 
WMFSDKNeeded : 0.0.0.0000 IsVBR : 0 DeviceConformanceTemplate: L1 Duration: 00:10:07.06, 
start: 0.000000, bitrate: 129 kb/s Stream #0:0(eng): Audio: wmav2 (a[1][0][0] / 0x0161), 44100 Hz, 2 
channels, fltp, 128 kb/s MediaInfo v24.06 General Complete name : 01 Track 1.wma Format : 
Windows Media File size : 9.34 MiB Duration : 10 min 7 s Overall bit rate mode : Constant Overall bit 
rate : 129 kb/s Maximum Overall bit rate : 129 kb/s Album : Unknown album (8/22/2016 10:51:04 
AM) Track name : Track 1 Track name/Position : 1 Encoded date : 2024-05-01 23:06:24 UTC Audio 
ID : 1 Format : WMA Format version : Version 2 Codec ID : 161 Codec ID/Info : Windows Media Audio 
Description of the codec : Windows Media Audio 9.2 - 128 kbps, 44 kHz, stereo 1-pass CBR Duration : 
10 min 7 s Bit rate mode : Constant Bit rate : 128 kb/s Channel(s) : 2 channels Sampling rate : 44.1 
kHz Bit depth : 16 bits Stream size : 9.26 MiB (99%) Language : English (United States)

HU2LMR

I don't have any additional comment on this. I have submit all answers and description.N79P6G

A second pass of the spectral de-noise was not used to reduced the broadband noise surrounding the 
voice because it started to eliminate the sibilance in the words. EQ, voice/dialogue isolate filters were 
also affecting the voice. I did not want to over process the recording to the point of affecting what was 
being said in the recording.

YPVLHE

Exact values and settings on each plug in used can be sent upon request.Z2HGN6

-End of Report-
(Appendix may follow)
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Test No. 24-5591: Forensic Audio Analysis

DATA MUST BE SUBMITTED BY Dec. 02, 2024, 11:59 p.m. EST TO BE INCLUDED IN THE REPORT

Participant Code: U1234A WebCode: YK3GPB
Test Instructions:
1. Apply filtration to reduce masking noise and increase the intelligibility of speech in the recording.
2. Guidelines described in section 4 of the SWGDE Best Practices for the Enhancement of Digital Audio should be followed.
3. Answer questions regarding the audio file properties, attributes of the audio content, and procedures to clarify the
speech.

Scenario:
A microcassette recording was made of an attorney calling in to a disciplinary hearing. Later, the microcassette was digitized
into a .wma file (“01 Track 1.wma”). The submitter of this recording stated that the original microcassette is no longer
available, but they need the speech in the digitized copy clarified in order to have it accurately transcribed.

This test is designed to measure your knowledge and skill in the following digital forensic audio processes: Data verification, Media
characterization, Audio processing, and Audio enhancement. These are based on the competencies outlined in section 3.6 of the SWGDE Core
Competencies for Forensic Audio.

Evidence:
To verify a complete and accurate download, use the tool of your choice to verify the integrity of the file.
24-5591 Audio.zip MD5 hash value: 197a7ddbd46ab1a852913f2a79126bf6
24-5591 Audio.zip SHA1 hash value: 68ab78c0c1a33fb59313fa216767a4679a50301f



 Test No. 24-5591 Data Sheet, continued Participant Code: U1234A
WebCode: YK3GPB

1-1). What is the SHA-256 hash value of the 01 Track 1.wma file?

1-2). What is the format of the audio file?

1-3). How many audio channels are contained in the audio file? Report a numeric value.

1-4). What is the length in time of the audio file?

1-5). What is the bit depth of the audio file?

1-6). What is the sample rate of the audio file?

1-7). What is the average value of the fundamental frequency of the dominant tonal noise present? Are harmonics of this tone present?
Fundamental frequency average value:

Harmonics present?

Yes  No 



 Test No. 24-5591 Data Sheet, continued Participant Code: U1234A
WebCode: YK3GPB

Part 2: Enhanced Audio Examination
A. Process the audio using filters to reduce noise and increase the intelligibility of speech.
B. Save the clarified audio in the uncompressed PCM Wave format, maintaining the original file sample rate and bit depth. It
is expected that only the channel containing speech data will be saved in the enhanced copy (The resulting file should be
one channel/Mono).

Uploaded file name:

2-1). Describe the workflow used to clarify the audio, including specific software and filters applied.



 Test No. 24-5591 Data Sheet, continued Participant Code: U1234A
WebCode: YK3GPB

Additional Comments
Please note: Any additional formatting applied in the free form space below will not transfer to the Summary Report and may cause your information to be
illegible. This includes additional spacing and returns that present your responses in lists and tabular formats.



 Test No. 24-5591 Data Sheet, continued Participant Code: U1234A
WebCode: YK3GPB

RELEASE OF DATA TO ACCREDITATION BODIES

The Accreditation Release is accessed by pressing the "Continue to Final Submission" button online and can be
completed at any time prior to submission to CTS.

CTS submits external proficiency test data directly to ANAB and/or A2LA. Please select one of the following
statements to ensure your data is handled appropriately.

 This participant's data is intended for submission to ANAB and/or A2LA. (Accreditation Release section below must be completed.)
This participant's data is not intended for submission to ANAB and/or A2LA.

Have the laboratory's designated individual complete the following steps
only if your laboratory is accredited in this testing/calibration discipline

by one or more of the following Accreditation Bodies.

Step 1: Provide the applicable Accreditation Certificate Number(s) for your laboratory

ANAB Certificate No.

A2LA Certificate No.

Step 2: Complete the Laboratory Identifying Information in its entirety

Authorized Contact Person and Title

Laboratory Name

Location (City/State)
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